
 

 

   

User Manual ReqEdit  

Release 2.14 

 
 

 

 

 

 

 

 

 

 

 

 

  



 

 

2 

2 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

Table of Content 
 
1. About this manual ................................................................................... 6 

2. About ReqEdit .......................................................................................... 6 
2.1 Starting ReqEdit .................................................................................................. 6 

2.1.1 Unzip ReqEdit archive ............................................................................................. 6 
2.1.2 Activate Demo license ............................................................................................. 6 
2.1.3 Activate ReqEdit Reader, Basic or Premium license ............................................. 6 
2.1.4 Prerequisites ........................................................................................................... 11 
2.1.5 File ........................................................................................................................... 11 
2.1.6 New ......................................................................................................................... 11 
2.1.7 Open ........................................................................................................................ 15 
2.1.8 Save ......................................................................................................................... 17 
2.1.9 Save As .................................................................................................................... 18 
2.1.10 Close ...................................................................................................................... 18 
2.1.11 CloseAll ................................................................................................................. 18 

2.2 Overview ................................................................................................................ 18 
2.2.1 Hide navigator ....................................................................................................... 20 
2.2.2 Column managing ................................................................................................. 20 
2.1.3 Handling of multiple open documents ............................................................... 21 
2.2.4 Closing of documents ............................................................................................ 22 
2.2.5 Tab Personalization ............................................................................................... 22 
2.2.6 Displaying of tab title settings .............................................................................. 23 
2.2.7 Setting of tab width ............................................................................................... 23 

3. Editing ..................................................................................................... 23 
3.1 Insert new object .................................................................................................. 24 

3.1.1 After ......................................................................................................................... 25 
3.1.2 Before ...................................................................................................................... 25 

3.2 Insert new child object ......................................................................................... 25 
3.3 Delete object ......................................................................................................... 26 
3.4 Copy and move objects ....................................................................................... 27 
3.5 Promote and demote objects ............................................................................. 29 
3.6 Default values ....................................................................................................... 30 



 

 

3 

3 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

3.7 Mass update function .......................................................................................... 31 
3.8 Data types .............................................................................................................. 32 

3.8.1 The Boolean type ................................................................................................... 32 
3.8.2 The Date type ......................................................................................................... 32 
3.8.3 The Integer type ..................................................................................................... 33 
3.8.4 The Real type .......................................................................................................... 33 
3.8.5 The String type ....................................................................................................... 33 
3.8.6 The Enumeration type ........................................................................................... 33 
3.8.7 The XHTML type ...................................................................................................... 34 

3.9 MainColumn .......................................................................................................... 36 
3.9.1 Status indicator ...................................................................................................... 36 

4. View - Filtering, Searching and sorting ............................................... 37 
4.1 Filtering .................................................................................................................. 37 
4.2 Search and replace ............................................................................................... 39 
4.3 Sorting .................................................................................................................... 40 

4.3.1 Delete sorting ......................................................................................................... 41 

5. Attributes and attribute types ............................................................ 42 
5.1 Attribute types (DataTypes) ................................................................................. 43 
5.2 Attributes ............................................................................................................... 44 
5.3 System attributes .................................................................................................. 45 
5.4 Specification Attributes ........................................................................................ 47 
5.5 Rearrange main column ...................................................................................... 48 

6. Links ........................................................................................................ 48 
6.1 Go to links .............................................................................................................. 49 
6.2 Links administration ............................................................................................. 49 
6.3 Add links ................................................................................................................ 50 
6.4 External Links ........................................................................................................ 52 
6.5 Delete Links ........................................................................................................... 53 

7. Server settings ....................................................................................... 54 
Connect ........................................................................................................................ 55 
Proxy Settings .............................................................................................................. 55 
Check Out .................................................................................................................... 56 
Check In ........................................................................................................................ 56 



 

 

4 

4 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

8. Pictures and OLE objects ...................................................................... 57 
8.1 Insert Image .......................................................................................................... 58 
8.2 Insert File ............................................................................................................... 58 

9. HTML Tables ........................................................................................... 59 

10. DOORS Tables ......................................................................................... 61 

11. Importing ................................................................................................ 62 
11.1 RIF 1.1a & ReqIF 1.0.1 ......................................................................................... 63 
11.2 Word import ........................................................................................................ 68 

11.2.1 Mapping file ......................................................................................................... 72 
11.2.2 Parsing details ..................................................................................................... 74 
11.2.3 Features and Limitations .................................................................................... 74 

12. Exporting ................................................................................................ 75 

13. Print ......................................................................................................... 78 
Main column ................................................................................................................ 79 
All visible columns ...................................................................................................... 80 
Print Setup ................................................................................................................... 81 

14. User settings .......................................................................................... 84 
14.1 Multilanguage support ...................................................................................... 84 
14.2 Delete temporary files ....................................................................................... 84 
14.3 ReqEdit Backup ................................................................................................... 84 
14.4 DOORS table attribute selector ........................................................................ 85 
14.5 Image caching ..................................................................................................... 85 

15. Document properties ............................................................................ 85 

16. Document views .................................................................................... 87 

17. Templates ............................................................................................... 87 

18. ReqEdit Log ............................................................................................. 88 

19. ReqEdit Buttons ..................................................................................... 89 

20. Keyboard Shortcuts ............................................................................... 89 

21. Contacting Support and Help ............................................................... 91 



 

 

5 

5 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

18.1 Help ...................................................................................................................... 91 
18.1.1 Help content ......................................................................................................... 91 
18.1.2 License info ........................................................................................................... 91 
18.1.3 Check for update ................................................................................................. 91 
18.1.4 About ReqEdit ...................................................................................................... 92 

18.2 Support ................................................................................................................ 93 
18.3 Error reports ....................................................................................................... 93 

22. Notices and limitations ........................................................................ 94 
22.1 Insert images and OLE objects ......................................................................... 94 
22.2 Generate preview images of OLE files ............................................................. 94 
22.3 Import/Export OLE objects ................................................................................ 94 
22.4 Import large OLE Files ........................................................................................ 95 
22.5 Export large OLE Files ........................................................................................ 95 
22.6 Copy and Paste ................................................................................................... 96 
22.7 Program environment ....................................................................................... 96 

23. Appendix ................................................................................................. 97 
ReqIF Namespace Reserved Attributes .................................................................... 97 
ReqEdit Namespace Reserved Attributes ................................................................ 97 
 

The ReqEdit XML Editor documentation starts on page 100.  



 

 

6 

6 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

1. About this manual 
Welcome to ReqEdit, a tool that is designed as a simple and portable ReqIF 
editor for Windows OS. This user manual describes how to use the basic 
features of ReqEdit.  

2. About ReqEdit  

2.1 Starting ReqEdit 

2.1.1 Unzip ReqEdit archive 

The first step for the ReqEdit installation is to copy the .zip archive file provided 
by REQTEAM to your desired ReqEdit location and unzip it. This will create the 
ReqEdit program folder. 

2.1.2 Activate Demo license 

To activate the demo license please execute the file 
„ReqEdit_demo_license_activation.exe“ provided by REQTEAM and press on the 
„apply update“ button.  

If the update is successful, you can start the software. In the menu Help -> 
License info you can check if the demo license of 15 days has been successfully 
activated. 

2.1.3 Activate ReqEdit Reader, Basic or Premium license 

Before running ReqEdit, the license needs to be activated. To do that, you need 
an internet connection and the license key provided by REQTEAM. 

Automatic activation 
The process is automated so the only thing you need to do is to execute 
„Start.exe” from your ReqEdit folder and copy your license key in the pop-up 
window if you want to install a local license. 

If you want to use network license you have to switch the radio button to the 
Flow License area and paste in the license server address. After you click 
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activate, a message will appeat telling you that the application needs to close for 
the settings to be applied. After that start the application again and it will grab a 
key from the license server. 

 

If your network requires a proxy for internet connections, you can find proxy 
settings in the “Proxy Settings” section. More information on proxy settings can 
be found here. 

If you install a new product key, select the corresponding radio button. If you 
are upgrading or extending your current license, select the „Update” radio 
button. 

After you click on activate, a progress bar will appear and show you the status of 
the activation. After the activation finishes you will get a success message and 
after clicking on OK, the program will start automatically. 

 

Manual activation 
Step 1: Open your web browser and access 
https://license.reqteam.com/ems/customerLogin.html. Log in using your 
Product Key. 
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Step 2: Click on the „Offline Activation Button”. 

Step 3: Download RUS tool. 

 

 

 Step 4: After the download is completed, open the RUS tool.  

Step 5: Select „Installation of new protection key” if you are installing a ReqEdit 
License for the first time. Click on the „Collect Information” button and save a 
.c2v file on your computer. Select the file name and please remember where 
you save the file! 
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Step 6: Switch to your web browser and upload the created .c2v file to the 
license generator. 

 

Step 7: Click on the „Generate” button and save the .v2c file to your computer. 
Please remember where you save the file!  
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Step 8: Switch to the RUS tool, click on the „Apply License File” panel and 
upload the created .v2c file. 

 

Step 9: Click on the „Apply Update” button. You will get a confirmation text after 
the license is successfully applied.  

Step 10: Open ReqEdit. You can check your license info by accessing Help -> 
License info in the ReqEdit main menu. 

 

After the license installation, the program can be started with „ReqEdit.exe” or 
„Start.exe”. 
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2.1.4 Prerequisites 

ReqEdit is a Windows application so in will only work on computers with a 
Windows operating system.  

To run the software, it is necessary to install .Net 3.51 Framework or else you 
will get the message „Some file is missing on your machine to execute the 
program“ and the program will not work. As the .Net Framework is used by 
many Windows applications, it might already be installed on your computer so 
checking before installation is recommended. 

2.1.5 File 

The ReqEdit Client is started. If you click now on file you can select either -> 
New, Open or Import. The description of these options will be explained in the 
following chapters. 

 

2.1.6 New 

Here we have the posibility to create two different document types: reqif file 
(*.reqif) and reqif archive file (*.reqifz).  

For each type of file you can select a template as your starting document. You 
can select the default template or one you have already defined. For more 
information on templates, please read the Templates section. 
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New Archive 
 

 

When a new archive action is initiated, a „Create new archive” window appears. 
A new file name has to be inserted. The only available type is: „Project Files 
(*.reqifz)”. 

 

If you save a new Untitled.reqif file, a new document will be created. The new 
document contains a single empty line with two columns, the Main Column and 
and the Comment Column. The Main Column contains the following attributes 
by default: Main Column = ReqIF.ChapterName + ReqIF.Name + ReqIF.Text. 
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The advantage of archives is that external files and images can also be added. 
The normal ReqIF file does not provide this function. 

New File 

 

You also have the posibility to create a new standard document (*.reqif). The 
new document contains a single empty row with two columns, the Main Column 
and and the Comment Column. 

For adding multiple attributes and attributes types, Settings -> Document has to 
be used. 

The attributes types added for a new document can be found in the table 
below. 
 

Attribute type Base type 
String XHTML 
Text XHTML 
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The attributes added for a new document can also be found in the table below. 

Attribute name Attribute type 
ReqIF.ChaperName XHTML 
ReqIF.Name XHTML 
ReqIF.Text XHTML 
Comment XHTML 
ReqEditID Integer 
ReqEditModifiedOn Date 
ReqEditModifiedBy String 

 

 

 

After the document has been saved, it looks like this: 

 

After the document has been saved, the hirarchical tree structure can be seen 
on the left side. The user has here the possibility to navigate easily to the 
requirements in the document. 
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On the right side in the grid view, the user can see all the attributes of a 
requirement in a single row. A document will always be displayed in this way. 
For more details have a look at chapter 2.2. 

Add new document 
 
ReqEdit also supports multi-document files. After you create a new .reqif or 
.reqifz file, you have the possibility to add a new document to your file. 

To add a new document to your file, go to File -> Add -> New document to the 
current file. 

 

NOTE: All documents will be stored in the same .reqif or .reqifz file. 

2.1.7 Open 

You can open a document if you click on File-> Open. For the selection of the file 
the selector window can be used.  By default, only xml, rif, reqif, zip and reqifz 
files are displayed. 
 

 



 

 

16 

16 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

If the file you want to open is a multi-document file, all included documents will 
be opened in separate tabs. 
 
If the selected document is a reqifz type, a list with reqif files of the zipped file is 
displayed. 
 

 

By clicking on the checkbox in front of the file names, you can select which files 
will be opened. All the documents in the selected reqif files will be opened in 
new tabs. 
 
NOTE: If the reqifz file contains only one reqif type document, the selector 
window mentioned above is not displayed and the document inside opens 
automatically. 
 
While opening the reqifz file, it is checked if documents contained in that file 
have already been opened in the program or not. If a document has not been 
opened yet, it will be opened and otherwise its corresponding tab is focused. 
 
If no hierarchical information is stored in the opened document, the tree view 
on the left side will not be displayed automatically.  
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Open recent files 
If you want to work on a recently opened file, you can use the “Open recent 
files” menu item. Up to six recently opened files are stored. 
 

 

Checking of file structures 
Before opening a file, the program checks the document content in two steps. 
First, the ROOT node of the xml type file is checked to determine the RIF 
version. Second, the file will be checked for the accurate schema for a valid 
format in order to avoid editing corrupt files. In case of corrupt files, the user 
will receive an error message. 
NOTE:  If you try to open a file that it is not a ReqEdit file type, the program will 
ask you if you want to import the file. If you select “Yes”, the import wizard will 
start and guide you through the import process.   

2.1.8 Save 

Saving is used for new and edited documents. For new documents the file name 
and path can be inserted in a Save dialog-box. In case of editing an already 
existing file, the program saves the modified data without asking and without 
any dialog-boxes. The edited but not yet saved state of the document is marked 
by a star (*) in the program. The same state can be seen on the tabs, too. It is 
possible to have multiple documents in the same file (Multidoc files), so a 
change in one of the documents has an impact on the others too. Changes in 
one document will automatically display all the other documents as changed, 
marked with a star (*). In case of archived files (zip, reqifz, rifz), the content will 
be automatically updated while saving. If your file is a multi-document file, 
saving one of the documents will also save the changes made in the other 
documents of the file. 



 

 

18 

18 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

 
NOTE: Changes on linked documents (e.g. Images or Word, Excel) will not be 
detected by the editor. To update the content, the content inside the XML file 
needs to be changed. 

NOTE: In case of large archived files (reqifz), saving can take a longer time. This 
happens because the archiving process is a more time consuming task. 

2.1.9 Save As 

Already existing documents can be saved with a new name with the “Save As…” 
command. A dialog-box is displayed where the name and place of the new file 
can be chosen. If the name already exists, the program asks as a confirmation 
whether you want to overwrite the existing file or not. After saving, the new file 
name can be seen it the header of the window and also in the tabs.  

2.1.10 Close 

The selected document (tab) is closed. If you try to close an unsaved document, 
the program asks if you want to save it. 

2.1.11 CloseAll 

It closes all open documents. Before closing, the program checks the state of 
the documents one by one and it asks if you want to save the changed 
documents. The operation can be interrupted by the Cancel button. 

2.2 Overview  

The main user interface (main Graphical User Interface, GUI) can be divided into 
four parts. The menu items are located on the top and under them, shortcut 
icons can be found. The commands can be sent from the menu and the most 
common ones are collected in the quick launch icons bar below. The quick 
launch icons can be moved by the mouse into four areas of the interface (upper, 
lower, right and left part of the window), which promotes better and more 
convenient workflow.  
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The middle part of the interface is used for reading and editing of an open 
document. You can read more about it in the Editing chapter. On the left side, 
main titles (title list) are shown in a tree view hierarchy which promotes easier 
transparency. If the new or edited document does not contain an address list, it 
is reported to the user with the following message: „No heading information 
available!”. On the right side, the main titles and description texts belonging to 
them can be seen in a table structure display.  
 
The title list situated on the left side also works as a bookmark.  
For example if a title is chosen on the left then the user will be guided in the 
document to the same title section of the document. The table structure on the 
right side displays also other data besides the description, such as status of the 
record. All of them appear in separate columns of the table. The order of the 
columns can be changed by an easy drag-and-drop operation. The width of the 
columns can be adjusted by clicking on the borders and moving the mouse left 
or right while pressing the mouse button. Columns can also be hidden or 
displayed by right clicking on a column header and selecting the columns you 
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want to show or hide from the „Columns” submenu. Titles get a sequence 
numbering automatically in the document navigator. 

2.2.1 Hide navigator 

The left-side document navigator can be displayed or hidden. The title of the 
menu is changing according to the status of the navigator.  
 
Numbering changes dynamically by adding or deleting of a new element. Nodes 
on the top level in the structure get a normal numbering. Sub nodes starting 
from a node above them (parent node) always inherit its numbering, expanded 
by a numbering received on their own level. Sequence numbering is illustrated 
by the following example: 
 
1. Title 1 on level 1 

1.1. Title 1 on this node level 2 (inherit 1) 
1.1.1. Title 1 on this node level 3 (inherit 1.1) 

1.2. Title 2 on this node level 2 (inherit 1) 
1.2.1. Title 1 on this node level 3 (inherit 1.2) 

2. Title 2 on level 1 
3. Title 3 on level 1 

3.1. Title 1 on this node level 2 (inherit 3) 
3.1.1.  Title 1 on this node level 3 (inherit 3.1) 

The footer is located on the bottom part where important data is displayed, 
such as number of rows in the document or the name of the order in progress. 
 

2.2.2 Column managing 

The position of the columns can be inverted, as well as they can be hidden and 
displayed. Inverting in Windows is performed by the usual technics, namely by 
drag-and-drop. This means, that the user selects the required column to be 
moved by the left mouse button and moves it to the required position by 
dragging, afterwards the user releases it. The visibility of columns can also be 
set from the local menu of the header, mentioned above. A submenu opens 
from the columns menu of the local menu, which contains all column names of 
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the document. The icons before the names mark the current state of the 
column, namely, if it is in hidden or visible mode. By clicking on the column 
name this state can be changed. Column names in the menu appear in the 
same order as they appear in the table. If a column dragging is performed, the 
order of the menu items is also changed. 
 
If the user makes a right mouse button click on “hide” the current column will be 
hidden. 
To show the column again, select in the menu columns the column you want to 
display. 
If you select the column name again it will disappear. 
The visible columns are indicated by a green checkmark and the hidden 
columns do not have a green checkmark. 
 

 

2.1.3 Handling of multiple open documents  

The opened documents are grouped into tabs which provide more 
transparency and easier handling of the documents. The name of the file and of 
the document is displayed on the tab. It can occur that in one file more 
documents have been saved. 
In this case every document can be seen in a separate tab.  
 
For each document contained in a specific .reqif file, the tab is marked with a 
colored circle icon. Each .reqif file will have a specific color assigned for all its 
documents. This way it’s easier for the user to handle documents from different 
.reqif files. 
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Names of the files containing the documents are displayed on the tabs. If the 
name for the file does not fit the given tab, it is marked with three points (…). 
More detailed data about the opened document can be gained by positioning 
the cursor above the tab. In this case, the following data appears in a ToolTip: 

• File location: it shows the entire path of the opened file. In case of a zip 
file it shows the name of the zip file.  

• File name: the name of the file. In case of a zip file, it shows the name of 
the file unpacked and opened from it.  

• Document name: shows the name of the document of the file.  
• Document ID: the identifier of the document. 

 

2.2.4 Closing of documents  

Every opened document can be closed by File -> Close menu item or by the 
closing button found on the tab (X). In case of closing of a not saved document, 
the program offers the save option for the user. Group closing can be started by 
File -> Close All. In this case it can happen that certain documents’ content has 
changed, and others’ has not. That is why the program checks all the documents 
before closing, and at every single not saved part it asks if the user would like to 
save it or not. In case of clicking on the Cancel button, the whole operation is 
interrupted. 

2.2.5 Tab Personalization  

In case of multiple opened documents, the order of the tabs can be changed 
easily with a drag & drop operation. The chosen tab can be moved between the 
other tabs with a simple mouse movement.  



 

 

23 

23 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

The following settings can be found in the “ReqEditSettings.xml” file by the 
program. More information on the configuration file can be found in the 
Program Environment chapter. This is an XML structured file whose editing can 
be performed manually. Every setting is going to be explained at the section 
belonging to it.  

2.2.6 Displaying of tab title settings 

Every tab displays the name of the document opened in it. The default file 
names are displayed from the beginning and longer names are cut at the end of 
the tab and marked by three points. The user can set if he would like to see the 
end of the file name on the tab instead of the beginning of it. In this case the 
three points are at the beginning on the tab and the end of the file name is 
displayed on it as a title. The name of the setting in the XML configuration file is: 
TabDocumentTextAlign. Its possible values are: 

• Left 
• Right 

In case the setting values differ the program applies the Left setting 
automatically.  

2.2.7 Setting of tab width 

The opened documents are always opened on a tab size determined in 
advance. The wider the tab is, the more can be seen of the name of the opened 
document file. The user can set these values in the TabDocumentWidth 
variable. Its default value is 250 px. In case of setting a wrong value the program 
uses the default setting automatically. 

3. Editing 
 

The biggest part of the window is occupied by the list for data editing. This 
displays data in a table in which every single column represents a data type and 
the rows contain data belonging to them. Every row has different height 
according to the cell content. During displaying, the program checks the content 
of the cells in the row and the value of the highest cell is given as a row height. If 
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this height is bigger than the height of the editor, the biggest height displayed in 
the editor is given to the row. 
Cursor and mouse can perform navigation between the cells too. Clicking F2 key 
or by double click on the cell can start data editing. Every single cell type has its 
own editor control, of which we can distinguish seven. 
The cells with grey backgrounds mean that the value (cell) is read only. XHTML 
attributes and the main column have white backgrounds even if they are read 
only. They can be opened normally but cannot be edited. 
If the user starts to edit one cell, then the cell background color will be light 
yellow. 
The content of the XML file is also changed and upgraded automatically by 
adding and editing data (and by saving it). 
We have the possibility to insert a new object, insert a new child object and 
remove an object from the document. Adding a new object is done by inserting 
a new row. The new row will contain all the attributes that are set for the 
document. 

 

3.1 Insert new object 

 

Adding a new object on the same level will create a new row in the table on the 
same level of the tree hierarchy. A new empty line will appear. In case it is 
edited, it will look like this: 
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3.1.1 After 

This option allows you to add a new object after the selected one, on the same 
level of the hierarchy. 

3.1.2 Before 

This option allows you to add a new object before the selected one, on the same 
level of the hierarchy. 

3.2 Insert new child object 

 

Add new object as child will create a new row in the table, below the selected 
line. It is a child in the tree hierarchy. A new empty line will appear. In case it is 
editted it will look like this: 
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3.3 Delete object 

Delete the selected object row. This function will place the removed object into 
a deleted state. The objects from this state can be seen with this option: 

 

Note! For being able to delete a row, the document needs to contain the 
„ReqIF.ForeignDeleted” attribute. If it doesn’t contain it, ReqEdit will ask if you 
want to add it. If you choose not to add the attribute, you will not be able to 
delete rows from the document. 

All the removed objects will be marked with red. Like this: 
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A deleted object can be restored by selecting it and clicking on the „Restore 
deleted objects” button from the toolbar menu or from the right mouse click 
menu. 

 

 
Note! The deleted objects and associated links are not removed permanently 
from the document, they are just marked as deleted using the 
„ReqIF.ForeignDeleted” attribute and removed from display. If the objects and 
links need to be removed permanently, the „Purge” function needs to be used. 

 

The „Purge objects” button can be found on the toolbar menu and in the „Edit” 
tree from the main menu. 

Note! The „Purge” function will permanently remove all rows which are marked 
as deleted. 

3.4 Copy and move objects 

Objects can be copied or moved by right clicking on a row in the main interface 
or on an object heading in the explorer and selecting copy or cut from the 
menu. 
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NOTE: If an object selected for copying contains links, the program will ask if you 
want to copy it with or without the links. Also, if the object has child elements, 
these will also be copied or moved. 

After you select copy or move, you can click on row in the main interface or on 
an object heading in the explorer and select the paste operation. You can paste 
the object before, after or as a child of the selected object. 

 

NOTE: In the object explorer you can also perform a copy or move operation by 
using a drag and drop mouse movement. For moving an object, just drag and 
drop the object to the desired location. If you want to copy the object, the CTRL 
button needs to be pressed while executing the drag and drop mouse 
movement.  
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3.5 Promote and demote objects 

The hierarchy of objects can be changed by using the “promote” and “demote” 
functions. 
As an example, when demoting an object, it will be changed to a child object of 
the object above it. 
In the images below you can see the effects of a demote operation. The 
indentation of the object has changed and also the chapter number has 
changed from 2.3.2 to 2.3.1.1, making it a child object of object 2.3.1. 
By using the promote function, a child object will be changed to a sibling of its 
former parent object. 

               

Demote function 

                  

Promote function 
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NOTE: If you promote or demote an object which has child objects, all the 
hierarchy of the object will be affected by the operation, promoting or demoting 
all the child objects along with the parent object. 

3.6 Default values 

Each attribute can have a default value defined in the “Document settings” 
section by selecting an attribute and accessing the “Attribute editor”. 
If a cell has a different value, the default value can be set back for each attribute 
of a row by right-clicking the corresponding cell in the grid and selecting the “Set 
default value” menu item. 

 

The cells where the default value is displayed has gray text color. 

NOTE: Although the main column attributes can have a defined default value, 
this value is not displayed in the grid view. The default value can be seen only in 



 

 

31 

31 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

the “Attributes” tab of the “Document settings” section. Also, the default value 
for boolean attributes is not displayed with gray text color. 

3.7 Mass update function 

A function for changing the value of an attribute for a set of rows is available by 
right-clicking on a column header. 

 

A window will be displayed, containing the number of rows for which the mass 
update applies and an input box specific for the type of attribute. 
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The mass update function is designed to be used together with the filtering 
function. This way, a set of objects can be selected according to specific criteria 
and updated at the same time. 

NOTE: The mass update function is not available for the main column. 

3.8 Data types 

3.8.1 The Boolean type 

Its value can be true of false. These two states are displayed by a check box on 
the screen. This is an exception type, double click on the cell is not necessary for 
editing. Its value can be altered by a single click.  

 

3.8.2 The Date type 

A real date can be written or set as its value. In the view mode, the cell shows 
the value of the date, but in the edit mode it displays the DateTimePicker 
controller used for selecting the date. This offers help for the user to select fast 
the exact date. The date value can also be removed by unchecking the box in 
the top left corner of the date picker. 
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3.8.3 The Integer type 

An integer can be given as a value between previously determined limits. In case 
of not giving a numeric type, the program will display an alert and the user can 
only continue if a correct value is entered. 

3.8.4 The Real type 

The value can be a decimal number between previously determined limits. In 
case of not entering a numeric type, the program will display an alert and the 
user can only continue if a correct value is entered. 

3.8.5 The String type 

An unformatted text with a previously determined length can be entered as a 
value. 
 
NOTE: The maximum allowed length of a string is 600 characters. This limitation 
was imposed in order for the files to be compatible with IBM Rational DOORS. 

3.8.6 The Enumeration type 

Two types of the enumeration type can be distinguished: single-value and multi-
value. 

The single-value enumeration type 
You can choose only one value from a previously determined value set. It shows 
the chosen value in cell viewer mode. In the editor mode you can choose the 
required value from a values list (ComboBox or DropDownList).  
Besides the values of an enumeration attribute type, the user can also select the 
<EMPTY> value to remove the value of a cell. 
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The multivalue enumeration type: 
You can choose multiple values from a previously determined value set. It 
shows the chosen value in cell viewer mode. In the editor mode you can choose 
the required values from a list by selecting each check box.  

 

3.8.7 The XHTML type 

A complex HTML content in an editor can be given as its value, which can 
contain a plain or a formatted text, images, objects and lists. Both, in the viewer 
or in the edit mode of the cell, the complex value can be seen. During editing, 
the HTML formatter on the icon toolbar becomes active. A possible content of 
the XHTML type can be the following:  

 

The icons used for editing are the following, which are only active in case of the 
XHTML type field: 
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• Bold – it changes the selected text or paragraph into bold. 
• Italic – it changes the selected text or paragraph into italic.                     
• Underline – it underlines the selected text or paragraph 
• Strikethrough – it strikes through the selected text or paragraph 
• Superscript – it changes the selected text or paragraph into superscript 
• Subscript - it changes the selected text or paragraph into subscript 
• Unordered list – it arranges the selected text or paragraph into an 

unordered list.  
• Ordered list – it arranges the selected text or paragraph into an ordered 

list. 
• Text Style – it sets the style of the current paragraph (it cannot set a 

selected paragraph) which can be the following: 
o Normal text 
o Heading 1 – Heading 6 

Formating options are also available by right clicking inside a XHTML cell or on a 
selected text from a XHTML cell. 

 

During the editing process, changes can be reverted by using the „Text undo” 
function from the right click menu or by using the CTRL + Z shortcut. The undo 
action can also be reverted by using the „Text redo” function from the right click 
menu or by using the CTRL + Y shortcut. 
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NOTE: After you leave the editing mode of the cell, the undo and redo functions 
will be deactivated and the change history of the text inside the cell will be 
erased from memory. 

3.9 MainColumn 

In this cell, the main fields of the document can be edited all in one. These fields 
are XHTML type attributes. Editing is performed by a TabControl, where every 
Tab contains an editor. In the view mode the totalized content of these fields 
can be seen.  The attributes displayed in the main column can be configured 
(see Rearrange main column). 

3.9.1 Status indicator 

In this column the user can see the row status. These are the possible statuses: 
• unchanged – marked with white color 
• edited – marked with light green 
• edited and saved – marked with light blue 

 
This column is always the first and the user cannot move, hide or set the 
columns width. This is a frozen column, which means that the user will always 
see the column, even if the document will be scrolled horizontally.  
If a user opens a document, every column is in unchanged mode. If cell content 
in the row will be changed, then the status will be edited (light green). After 
saving, this status will be „edited and saved” (light blue). 
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This column also includes link information if it is available. If an object contains 
a link, a symbol will be displayed according to the link type. Incoming links will 
be displayed using a red arrow and outgoing links using a green arrow. 
 

 
 
For more information about links, please read the Links chapter. 
 

 

4. View - Filtering, Searching and sorting 

4.1 Filtering 

Filter settings can be configured here, such as giving filter conditions or deleting 
a filter.  

An already existing filter condition can be edited or a new one can be created by 
clicking on the „Add new or edit filter” menu item. This can be performed on the 
following user interface: 
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There is no filter condition in case of the first opening, so the window is empty. 
The “Add new criteria” button can add new filter conditions. It consists of the 
following fields:  

1. You can select from a list by which column you want to filter. Rows can 
also be selected if we want to filter by links. 

2. You can select from a list what the searched value has to correspond to. 
3. The third field depends on the field type selected and contains the 

searched value. 
An endless number of filter conditions can be given. The logical connection 
between them can be given by the „Match all conditions” and the „Match one of 
the conditions”. The first means a logical AND and the second a logical OR. The X 
button can delete a filter condition and all of them can be deleted by the „Clear 
all criteria” button.  
Filtering is performed by clicking on the OK button. At this time, only the 
element (title) remains active on the navigation panel, where the list element 
belonging to it can also be seen, and the others change into grey. In case of a 
repeated opening of the window, the built up filter conditions can be edited. 
Switching off the filter is possible. As an effect, the whole document can be seen 
again and the given filter conditions are not lost. The Activate Filter or 
Deactivate Filter menu item of the Filter menu can be activated again. The 
Delete Filter menu item performs deleting of a filter. Filter commands can be 
given from shortcut icons too. 
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4.2 Search and replace 

By clicking on the menu, the search panel opens on the top of the editor 
window, which is shown on the following diagram: 
 

 

The text, which is searched for can be given in the search field. Searching is 
started by the ENTER button or by the Previous or Next buttons next to it. The 
column(s) where the program will search for the text can be selected from the 
„Search in” list. The options are:  

- Main Column, which searches in the three main fields (ChapterName, 
Name, Text).  

- Entire document, which searches in all fields of the document.  
- ForeignID, which searches only in the Foreign ID field. This option can be 

selected only if the ForeignID field is defined in the current document. 
  

Coloring the cell into green shows the results. The Previous and the Next 
buttons can perform navigation between the results. The number of the results 
is also displayed after the „Search in” selector list. If you reach the end of the 
search, it is signaled by a message. By entering a new text and by starting the 
search, the old search is deleted automatically and the new one is started.  
Searching can be deleted by the Cancel button or by closing of the search panel 
by clicking the X button located on its right side. 
 
By clicking on the “Replace” button on the toolbar, the following form will be 
displayed: 

 
 
For the search and replace function, you need to add in the search field the text 
you want to replace and in the “Replace with” field, the text you want to replace 
it with. 
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By clicking on the “Replace” button on the form, the program will search for the 
first occurrence of the searched text and highlight it. By clicking the button 
again, the searched text will be replaced with the text from the “Replace with” 
field and the next occurrence will be highlighted. 
If you don’t want to replace a specific occurrence, you can skip it by clicking on 
the “Next” button. 
The number of replaced items will be displayed after the “Replace all” button. 
By clicking the “Replace all” button, the program will automatically replace all 
occurrences of the searched text.  

NOTE: The replace function works only for the Main Column. 

 

4.3 Sorting  

Data displayed in the list can be sorted according to one or more conditions. 
The usual clicking on the list header performs the single sorting in Windows. It 
means the header of the column has to be clicked on, according how the user 
would like to sort the list. 
 
Multi-sorting according to more conditions can be done the same way, with a 
difference. During clicking on the header, the user has to hold the CTRL button. 
In this way a signal is given to the program that the user would like to sort the 
data according to more columns. This time the program sorts on the already 
sorted data according to the new added condition (column). 
 
In this way data can be sorted according to any number of columns. If you like 
to sort data according to new columns, (you would like to delete the already 
existed sorting) the CTRL button has to be released during clicking on the new 
column. As a result, sorting according to the already existed columns is deleted 
and the program sorts the list according to the column which has been clicked 
on. After this, the required sorting columns can be compiled by also holding the 
CTRL button.  



 

 

41 

41 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

Sorting can be performed according to ascending and descending order. 
Changing the order can be performed by re-clicking on the column header (in 
case of multi-sorting the CTRL or Shift+CTRL button also has to be held). The 
numbered icon found on the right of the header marks the sorted columns and 
their direction. The number marks the priority of the sorting and the seated or 
standing triangle after it marks the sorting direction. The ▲ sign marks the 
ascending and the ▼ sign marks the descending order. 
Setting of ascending and descending order can also be set from the local menu 
of the column. This menu can be displayed by right clicking on the given column 
header, where Sort ascending and Sort descending menu items can be selected.  
 

 

 

4.3.1 Delete sorting 

Sorting according to the given columns can be deleted. After deleting, data is 
restored to the order defined during document loading. 
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5. Attributes and attribute types 
 

Editing of datatypes and specObjectTypes belonging to the document can be 
performed by accessing the “Document Settings” menu item. Its user window is 
the following: 

 

NOTE: Before accessing the document settings, the file needs to be saved. If the 
file was not saved by the user, the program will automatically ask to save it. 
More details on file saving can be found here. 
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5.1 Attribute types (DataTypes) 

Datatypes in the document can be seen in the list. The name of the datatype, 
type, (extended by the individual properties belonging to the type) and its last 
modification date can be seen in the columns. The description of the selected 
datatype and in case of Eumeration type its values can be seen on the right side 
in the list. A new type can be created using the buttons under the list, an already 
existed type can be edited or rather deleted. By clicking on the New and Edit 
(editing of a datatype can be started by double click on the list) buttons we get 
the same surface where properties of the datatype can be given or modified. 

 

Properties can vary according to the selected datatype. Properties to be reached 
at a special datatype can be seen in the following table: 

 Long 
Name 

Description Min Max Accuracy Enum 
Values 

Boolean X X     
Date X X     
Enumeration X X    X 
Integer X X X X   
Real X X X X X  
String X X  X   
XHTML X X     
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In case of an enumeration datatype values can be extended or deleted  with the 
buttons found in the right top corner of the list. Value editing can be performed 
by overwriting the value in the list. The value of the NEW VALUE has to be a 
number, it is not necessary to be unique. LABEL values have to be unique, the 
program obliges the user to keep this. After adding the new datatype or after 
modifying an already existing one, modifications become visible right away in 
the list of the previous window. The final modification is performed after clicking 
on the Save button of the Document Settings window. By clicking on the cancel 
button, all the recorded and modified data will be lost. 

By clicking the delete button, attribute types can be deleted but only if there are 
no attributes of that specific type present. If such attributes are present, you will 
get a pop-up message containing the names of those attributes. To be able to 
delete the attribute type, first you need to delete all the attribute fields of that 
type. 

NOTE: The following data types have attribute types created by default: integer, 
real, date, string, xhtml and boolean. 

5.2 Attributes 

Attributes of the document can be reached by clicking on the Attributes tab. Its 
structure is very similar to the ones mentioned above with an exception, that on 
the right it displays the default value defined at the attributes referring to all 
types. Adding a new attribute, editing of an already existing one, and deleting 
(NOTE: in this version the user can delete only the new created attributes) can 
also be started from the buttons found at the bottom of the list. By clicking on 
the New and Edit buttons, the following surface is displayed:  
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The required attribute type can be selected in the upper list, the name, 
description and other properties of the defined attribute can be selected in the 
other fields:  

• Multivalued – it can be activated only in case of an enumeration type, 
which can have one or more values at the same time 

• Read Only – it determines the editing right of the object 
• Default Value: every object can have a default value, which it gets if it is 

added to the document as a new element. This value can be set 
according to the „attribute type”. On the right side of the surface in the 
upper list, the user can see data of the selected attribute type, on behalf 
of the better transparency.  

By clicking the delete button, attributes can be deleted. Please consider that all 
data stored in the fields related to the deleted attribute will be lost. 
 

5.3 System attributes 

There are 6 attributes which are created by default with each new file. They can 
be distinguished from the other attributes by the computer symbol in front of 
their name. 
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Three of them are part of the main column and consist of the following 
attributes: 

• ReqIF.ChapterName – editable XHTML attribute  
• ReqIF.Name – editable XHTML attribute  
• ReqIF.Text – editable XHTML attribute  

More info on these 3 attributes can be found in the Main column section. 

The other 3 system attributes are: 

• ReqEditID – integer type, read-only attribute 
• ReqEditModifiedOn – date type, read-only attribute 
• ReqEditModifiedBy – string type, read-only attribute 

ReqEditID is an auto-incrementing ID number used for identification of the 
objects inside a ReqEdit document. 
ReqEditModifiedOn stores the last modification date of each object. 
ReqEditModifiedBy stores the Windows username of the user who was the last 
to edit the object. 
These 3 system attributes cannot be edited and are by default hidden. 

NOTE: System attributes cannot be deleted. 
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5.4 Specification Attributes 

You can add to attributes to the specification/document. The attributes will only 
be stored as metadata for the specification/document. You can add/edit and 
view these attributes and their values in the document tab. 

Adding new document attribute 

Overview of the document attributes 
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5.5 Rearrange main column 

The main coulumn  contains by default ReqIF.Chaptername as Heading (with 
automatic numbering), ReqIF.Name as Description and ReqIF.Text as content. 
You have the possibility to rearrange the columns or even to select other XHTML 
attributes that are displayed in the main column. 

 

6. Links 
 
Starting with ReqEdit 2.0, link support was introduced. Link information is 
displayed in the status indicator column, at the begining of each object row. 

 

If an object contains links, a link symbol and arrows indicating the link type are 
displayed inside the status indicator column. The red arrow indicates an 
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incoming link and the green arrow indicates an outgoing link. If an object 
contains both types of links, both types of arrows are dispalyed. 

6.1 Go to links 

To follow a link to its destination or source, you have to perform a right click on 
the object row and go to the „Go to links” menu item. A submenu will open and 
dispaly the available links. A submenu item contains a symbol for incoming or 
outgoing link and according text „Go to source” or „Go to target” and also the 
object text (in case there is any available) or the ReqIF ID of the source or target 
object. 
A link can be incoming from or outgoing to an object from the same document 
but also to another document. When clicking on a link in the submenu, the 
linked item will be selected and displayed on the first row in the grid. If the 
linked object is contained in another document, the program will automatically 
switch to the document’s tab and select the linked object. If the document 
containing the linked object is not opened in ReqEdit, the program will ask if you 
want to open it. 

NOTE: Currently we only support links between objects inside the same ReqIF 
file. If an object contains a link to another ReqIF file, the text „The target is 
placed in an outer file...” will be displayed in the links menu. 

6.2 Links administration 

The link administration tab can be accessed from the “Document Settings” 
window. 
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In this section, all link sets related to the selected document can be viewed and 
administrated. You can change the link set name and description and also edit 
each individual link’s name and description related to that link set.  

6.3 Add links 

In order to create a new link, first you have to create a “start link” by right 
clicking on an object and then going to the “Add link” menu and clicking on 
“Start link” in the submenu. 
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After creating the start link, an icon will appear in the status column of the 
source object. 

 

The next step is choosing a target object for the link. You can do this by right 
clicking on an object and selecting “End link” from the “Add link” submenu. 

 

Next, you can add links to some other objects starting from your source object, 
by repeating the last step. After you added all your links from the source object, 
you can click on the “Remove start link” menu item from the “Add link” 
submenu. 
After removing the start link, you can add a new one to another object. 
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6.4 External Links 

ReqEdit offers you the possibility to store external links in your ReqIF document. 
This can be either an OSLC or a Web URL. Please select in the row you want to 
link and use the right mouse click to open the related menu and select the entry 
“Add external link”. After selection, you will see this input dialog. 

 

You can define with the long name a display name for the link. In the field URL 
please enter a valid URI (including protocol prefix like http:// ). The field link type 
is optional, and should be used to classify links (like derives, implements). 

For the link direction, you can choose between INWARDS and OUTWARDS. The 
selection has no impact on the function, it is just a semantic. The field 
technology determines how the link is intended to be open. Currently all links 
will be opened with your default browser. 

You can add an additional description to the link as well. If you now press “Save” 
button, you will see the link in the Go to links menu with the selected name. If 
you don’t define a name the URI will be displayed. 
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If you want to edit the external link, than please select in the right click menu 
the entry “Edit external links” and select the link you want to edit: 

 

If you click on the edit button, then you will get the same dialog described 
before. Here you can edit all the properties of the external link. 

Please take in consideration, that this feature is not implemented currently by all 
tools, that support ReqIF. This information may get lost if you import the ReqIF file 
generated by ReqEdit to other tools, that not support this feature. 

6.5 Delete Links 

To delete a link, you must right click on an object that contains one or more 
links and go to the “Delete link…” menu item. After clicking it, a window 
containing all links of the object will be displayed. 
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Only outgoing links can be deleted from an object. If you want to delete an 
incoming link, you must delete it from the source object. 
For deleting outgoing links you have to select them by clicking on the checkbox 
at the beginning of the rows and click on the “Delete” button afterwards. 
 
NOTE: Incoming links have a grey background and cannot be selected. 

 

7. Server settings 
 

For connecting to the server you need to setup first the connection to the 
server. For connection the mandatory fields are:  

• Host name 
• User name 
• Password 

Note! If the connection settings are saved then the connection can be initiated 
from toolbar. 
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Connect 

If the connection settings are saved then the connection can be initiated from 
toolbar. 

 

Proxy Settings 

If your network requires a proxy for internet connections, you can find proxy 
settings in the “Server Settings” section. The username and password fields are 
not mandatory to be set, only the address and port fields are. These proxy 
settings can be selected to be used for the ReqEdit Server and the automatic 
updater and license activator, by checking the corresponding boxes.  

Note! Currently ReqEdit does not support NTLM Authorization Proxy Servers. 
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Check Out 

When the connection is established a Check Out can be made. This Check Out 
function is adding the possibility of downloading a project from server. From the 
hierarchy you can choose a project and press Check Out. When the download is 
completed the project is automatically opened in ReqEdit client. 

If there is already a file with the same name in the folder where you are trying to 
do the Check Out, for data security, ReqEdit will not overwrite the file. To be 
able to save and use it in that folder you will have to rename the file in the 
download window and it will be connected to the server file. A file that has been 
manually renamed by the user after the Check Out process, will not be checked 
in back on the server as a new revision of the checked out file, but as a new file. 

Note! When a project is on Check Out mode on server is locked for any other 
users until the Check In is made.  

 

Check In 

When the connection is established a Check In can be made only in case there is 
already a Check Out made for that project. This Check In function is adding the 
possibility of uploading the changes of a project to server. From the actual 
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opened document you can press Check In and choose the hierarchy folder 
where the document will be uploaded. Optionally you can also add a comment 
to your check in. 

 

8. Pictures and OLE objects 
 

It is possible to  insert images and files in the reqifz archive files because reqifz 
archive files are having a zip archive which allows to store there several 
information such as pictures and OLE objects. The usual reqIF file is just meant 
for text editing. So in the case the user wants to add other information like 
pictures and OLE objects a reqifz archive file needs to be created.  
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8.1 Insert Image 

 

Inside the XHTML fields, like Main Column -> ReqIF.Text there is the possibility 
to add a new image. 

The supported files are: png, bmp, jpg, gif, ico, wmf. 

There is also the possibility of enlarge/strech the image inside the editor. 

 

8.2 Insert File 

Inside the XHTML fields, like Main Column -> ReqIF.Text there is the possibility 
to add a new file. 

All the files are supported in case the user has an installed application on the PC 
to open it. ReqEdit can only open natively ReqIF file formats. 
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For the Pdf, office documents and images the related icons will be displayed.  

 

If we double-click on the icon the related application will open the file and 
allows to handle the file in the proper way. 

9. HTML Tables 
 
For working with table structures, ReqEdit uses the HTML table format. This 
tables support the same type of data like a XHTML attribute (formatted text, 
images, file attachments). 

 

A HTML table can be created by clicking on the corresponding main menu item 
or by clicking on the „Insert table” menu item from the right-click menu while 
editing a XHTML cell. 



 

 

60 

60 
Oberanger 30  

80331, München, Deutschland 

+49 89 21548150 

+49 89 21548151 

info@reqteam.com 

www.reqteam.com 

 

 

When creating a table, you can select the number of rows and columns to be 
added initialy to the table. 

NOTE: The maximum number of columns that can be added is 30 and the 
maximum number of rows is 100. 

 

After the table is created, rows and columns can be inserted or deleted by using 
the right-click menu items. 
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10. DOORS Tables 
 
ReqEdit offers support for DOORS tables when importing a file from IBM 
DOORS. The table structure and content is preserved and displayed in ReqEdit 
after import. The cell content can be edited in ReqEdit but the table structure 
cannot be changed (add or delete rows or columns). A cell containing a DOORS 
table cannot contain any other items (text or attachments) and cannot link or be 
linked from other objects. 

The attribute values which are displayed in the table cells can be selected from 
the user settings menu (see Chapter 14.4 for details). 

The default DOORS table attributes (ex: TableBottomBorder, TableCellAlign...) 
are hidden from display but can be shown by right clicking on the column 
header and choosing to display them in the column list.  

NOTE: By changing the table attributes manually, there is a risk that IBM DOORS 
will not import back the file correctly if the modified parameters are out of 
bounds. 
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DOORS Tables are displayed by default in the HTML table format (see Chapter 9 
for details). By accessing the right click menu on a row containing a DOORS 
Table, you can select to display the table in expanded format. 
In the expanded format, you can edit all the individual attributes for each table 
cell, not only the three main attributes which you can select to be displayed in 
the table format (ReqIF.ChapterName, ReqIF.Name and ReqIF.Text). Links can 
also be added for each table object. 
The table header structure and row structure are also displayed in the 
expanded format but the cells are not editable and cannot contain links. 

 

11. Importing  
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The ReqEdit editor supports the ReqIF Format as open platform for many of the 
tools that are on the market. So the file attachments and images are stored in 
the archives as they are (no conversion of any type necessary) and for 
formatting we are using the XHTML tags that are designated for this purpose. 

Not all tool vendors share this spirit, and they have their own kind of 
implementations that need to be adapted. One of these tools, IBM Rational 
DOORS, uses for external file reference an OLE wrapping around each of the 
files. This is ReqIF conform, but not intended. So ReqEdit needs to un-wrap this 
OLE envelope to get to the original file. This is happening during the import. 
ReqEdit creates a new file, with all the original files inside. The filename is like 
the original one, but has an additional suffix called “_imported” in the name. 
This imported file can be edited. The linked external files can be opened with an 
application for the specific file type. 

11.1 RIF 1.1a & ReqIF 1.0.1 

In order to edit files coming from DOORS (directly or via Atego Requirement 
Synchronizer) you need to execute an import, by clicking on File->Import. 

NOTE:  IBM Rational DOORS version. 9.5.2 and Atego Requirements 
Synchronizer 2.4 have been tested. 

By clicking the “Import” menu item, a wizard will be opened and guide you 
through the import process. 
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On the first page of the wizard you will find some information about the wizard 
and a link to the documentation. By selecting the “Do not show me this start 
page next time” check-box, this page will not be shown anymore on the wizard 
start-up. 

In the next page of the wizard, the format of the file you want to import has to 
be selected. The available options are “IBM Rational DOORS© compatible ReqIF 
format”,  “Rational DOORS Next Generation”, “RIF 1.1a format” and “Word 
format”. 
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The following page lets you select the file you want to import and also the 
destination path and name for your output file. 

 

After selecting the file paths and clicking next, the program will do a pre-
validation check and verify the objects IDs. Some valid RIF IDs may not be valid 
in ReqIF format, thus creating invalid files. It is possible that some requirements 
management tools can also generate invalid ReqIF IDs. If some IDs are not valid, 
the wizard will ask if you want them to be fixed or not. If you agree, the wizard 
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will fix the IDs and after the validation, you can continue with the importing 
process, or else the wizard will stop. 

 

On the next page, the program will check the file structure and compare it 
against the ReqIF or RIF schema. If the process is successful, the file can be 
imported. If you click on the “Next” button, the file will be imported. 

 

After the file is imported, a confirmation page will be displayed. Here you can 
see several statistics about the imported document and an info panel were 
warnings and errors are displayed in case something occured during the 
import. 
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NOTE: If you import a file from RIF format, another page containing mapping 
tables will be displayed after the pre-validation. This page contains tabs for each 
file (in case of a RIF archive) and for each document contained in the xml files. 
For each document you can set the destination attribute name for every source 
attribute. 

 

NOTE: Please consider that some attribute names are already in use by the 
ReqIF standard and have a pre-defined type. ReqEdit has also a set of attribute 
names that must not be assigned by the user. You can find a list of these 
attributes here. 
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Also, for best interoperability between tools, use only the following characters in 
the attribute names: 

• Alphanumeric characters (letters of the alphabet and numbers) 
• Space characters 
• Periods (.) 
• Underscores (_) 
• Hyphens (-) 

 

Rational DOORS Next Generation Limitations 

• Works with Rational DOORS Next Generation version 6.0.2 and above. 
• Until DNG reaches version 6.0.4, Workflows in ReqIF roundtrips are not 

supported. 
• Links between artifacts are not supported. 

 

11.2 Word import 

The Word import is an extra feature that can be requested when purchasing 
your ReqEdit license. This feature works like the other import functions and 
supports the import of .doc, .docx and .rtf files. 
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The Word import can be started by opening the same import wizard as for the 
other file types and selecting the third option, “Import Word format files”. 

 

The next wizard page lets you select the input and output files. 
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After selecting the input and output files, the next page displays a list of options 
for the import. The available settings are: 

• Keep hierarchy information – will recreate the parent/child structure 
found in the Word document, based on Heading levels. If not enabled, all 
Headings will be displayed on the first level. 

• Remove manual chapter numberings - with the format 
(<number>(.<number>)*). 

• Import images - if the option is selected, embedded images (JPG, PNG, 
BMP) in the Word document will be imported to ReqIFz file and 
referenced inside the ReqIF object. If the option is not selected, all 
images in the Word file will be ignored. 

• Import attachments - if the option is selected, embedded objects (Word 
(rtf, doc, docx), Excel (xls, xlsx), Powerpoint (ppt, pptx)) in the Word 
document will be imported to ReqIFz file and referenced inside the ReqIF 
object. If the option is not selected, all objects in the Word file will be 
ignored. 

• Import tables - if the option is selected, all tables will be parsed an 
converted to a ReqIF compatible (HTML) table. If the option is not 
selected, all tables in the Word file will be ignored. 
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• Import attribute tables – if the option is checked, a selection "First 
row"/"First column" is displayed for parsing option; a field for mapping 
file selection is also displayed.  

 

In the next step, the wizard will start the import process with the user defined 
settings. 

 

On the last page of the wizard you can see details regarding the import. In the 
upper part of the page, you can see the numbers of the imported elements. 
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Warnings and other information (if necessary) are displayed on the lower part.  
More details on the import operation can be found in the main log file, where 
each element status is logged individually. 

When the process reaches the end, the output file can be opened directly. 

11.2.1 Mapping file 

The mapping file is used to translate attributes from attribute tables into ReqIF 
specific attributes. 

If the „Import attribute tables” option is selected and the mapping file is found, 
the importer will parse the first row or first column (as specified by the user) for 
the attributes found inside the mapping file. If no attribute is found, the table 
will be imported as a simple HTML table. If at least one attribute is found, the 
table will be imported with each row as a requirement. 

An example of the content of a mapping file: 

Attribute_1 | Attribute_A | string 
Attribute_2 | Attribute_2 | text 
Attribute_3 | Attribute_B | integer 
Attribute_4 | Attribute_4 | real 

If no type is given, the default type will be text: 
 
Attribute_5 | Attribute_C  

For a real number attribute, you can set the decimal separator as . (dot) or , 
(comma). If the separator type is not set, the deafult will the . (dot). 
 
Attribute_6 | Attribute_6 | real: . 

For a date attribute, you can set the display format. If the format is not set, the 
deafult format will the one seen in the example below: 
 
Attribute_7 | Attribute_D | date: dd.MM.yyyy 

On left side are the attribute names for which the importer will search in the 
tables and on the right side will be the attributes inside the output .reqifz file. 
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Between the square brackets, the user can define the type of the attribute (if it’s 
empty, the importer will set the default type „text”). The mapping file should be 
saved with UTF-8 encoding. 

NOTE: Please consider that some attribute names are already in use by the 
ReqIF standard and have a pre-defined type. If you decide to assign these 
names to some attributes, use the correct attribute types. ReqEdit has also a set 
of attribute names that must not be assigned by the user. You can find a list of 
these attributes here. 
 
Also, for best interoperability between tools, use only the following characters in 
the attribute names: 

• Alphanumeric characters (letters of the alphabet and numbers) 
• Space characters 
• Periods (.) 
• Underscores (_) 
• Hyphens (-) 

Common errors and warnings 

A common error for a file being unable to import is the case in which you have 
an attribute table inside your file but one of the heading row values is missing. 
To correct this problem, just make sure that the header row of your attribute 
table is complete. If the name of an attribute is not found in the mapping file, it 
will be automatically created as a text attribute. If you want to have the attribute 
as a specific type, make sure you add it to the attribute mapping file. 

Not all attribute names from the heading of an attribute table need to be 
defined inside the mapping file (only one is mandatory for the table to be 
considered as an attribute table), but all cells need to have a value. 

If you get any warnings regarding the conversion of a specific value to a certain 
type, make sure the values in your attribute table inside the Word file are all 
correct. This can appear due to a mistype inside the Word file or a wrong 
attribute type specified in the mapping file. To fix this, check your values inside 
the Word file (an example for a wrong value for an ID of integer type is a value 
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of 123a) and also check if the attribute type is correct in the mapping file. If the 
types do not correspond (this is the case for boolean, integer, real, date and 
string types), the program will automatically convert the type to text and you will 
get a warning message. 

11.2.2 Parsing details 

The parser will translate each heading into a chapter name and each paragraph 
into a requirement. If the file contains a bullet list, ordered list, attachment or 
image, it will be added to the same requirement as the paragraph above it. 

Simple tables will be translated into HTML tables in the output .reqifz file. 

The output file will always be a .reqifz file so it is easier for the user to add 
attachments or images afterwards. 

11.2.3 Features and Limitations 

Features: 

• Import headings as chapter names 
• Import paragraphs as text 
• Import all main text formatting(bold, italic, underline, striketrough, 

superscript, subscipt) 
• Import all unicode characters 
• Import ordered lists 
• Import unordered list  
• Import attachments (optional) 
• Import images from .doc and .rtf (optional) 
• Import tables as HTML tables (optional) 
• Possibility to keep hierarchy based on heading level 
• Possibility to remove manually added chapter numberings before 

headings 

Limitations: 

• Import images from .docx not supported yet 
• Cell merging on tables larger than one page is supported yet 
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• Import attribute tables as requirements with attributes not supported 
yet 

• Starting ordered list with a value different from „1” is not possible due to 
a limitation in the ReqIF standard 

• Different fonts 
• Font size, color, background color, styling  
• Text alignment  
• Document comments 
• Text box, Footnotes 
• Shapes, charts, smart art, word art, quick parts, images in tables 
• Webdings, Wingdings 
• Heading, Footer 
• Macros 
• Changes on a document with Track Changes enabled 
• Restrict editing 
• Word file properties 
• Word fields 

12. Exporting 
 

If the files that the user edits or creates should be imported to IBM Rational 
DOORS (directly or via Atego Requirement Synchronizer), an export is necessary. 

After editing and before importing to DOORS, you have to do an export by 
clicking on File->Export. During the export all the linked files will be wrapped in 
an OLE envelope. To protect the ReqEdit variant of the ReqIF file, the export 
function will ask the user for a new file name, where to save the DOORS variant. 
This new file can be imported to IBM Rational DOORS. 

NOTE:  IBM Rational DOORS version. 9.5.2 and Atego Requirements 
Synchronizer 2.4 have been tested. 

By clicking the “Export” menu item, a wizard will be opened and guide you 
through the export process. 
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On the first page of the wizard you will find some information and a link to the 
documentation. By selecting the “Do not show me this start page next time” 
check-box, this page will not be shown anymore on the wizard start-up. 

In the next page of the wizard, the format of the file you want to export has to 
be selected. The available options are “IBM Rational DOORS© compatible ReqIF 
format”, “Rational DOORS Next Generation”,  and “RIF 1.1a format”. 

 

The following page lets you select the destination path and name for your 
output file. In case you want to export to RIF format and your file is a multi-
document file, multiple .zip files will be created at export. In this case, only the 
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destination folder can be selected and the file names will be assigned 
automatically. 

 

After selecting the file paths, the wizard will convert your file and a confirmation 
page will be displayed. Here you can see several statistics about the exported 
document and an info panel were warnings and errors are displayed in case 
something occured during the export. 

You can find your exported files in the destination directory you have specified 
on the previous page. 

 

NOTE: If you export a file to RIF format, another page containing mapping tables 
will be displayed after you select the file paths. This page contains tabs for each 
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file (in case of a multi ReqIF file archive) and for each document contained in the 
.reqif files. For each document you can set the destination attribute name for 
every source attribute. 

 

 

 

 

13. Print 
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Printer setup 

 

Main column 

This printing function will prepare for printing only the main column of the 
selected document. The content can be seen before printing on the print 
preview window. The visual output of the print preview is similar like the 
content from the ReqEdit client grid. Bellow you can see a screenshot of the 
print preview. 
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All visible columns 

This printing function will prepare for printing all columns of the selected 
document. The content, before printing, can be seen on the print preview 
window. The visual output of the print preview is similar like the content from 
the ReqEdit client grid, only for main column, the attributes appear into a grey 
box bellow each main column row.  

Note! For selecting which columns you want to appear on the print you can use 
the Hide function. Only the visible columns will be printed. 

 

Bellow you can see a screenshot of the print preview. 
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Print Setup 

The print setup section can be accessed from File -> Print Setup. 
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The print setup window has 3 tabs where you can set up the Header, Footer and 
Cover page. 

In the Header section you can select if you want to display any information on 
the top of the page. You can choose to display a logo image, a document title 
and a custom text. Each of these can be positioned on the left, center or on the 
right side of the header. 

In the Footer section you can select if you want to display any information on 
the bottom of the page. You can choose to display you username, page 
numbering with options to display the single page number or the page number 
out of the total pages and the current date with options for the date format. 
Each of these can be positioned on the left, center or on the right side of the 
footer. 
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In the Cover page section you can select if you want to print a cover page and 
the information to be displayed on it. You can select following sections to be 
displayed on the cover page: logo (image must be selected in the header 
section), title (specification long name), document metadata (file name, created 
on date, printed by and project title) and a custom text area. Each of these can 
be positioned on the left, center or on the right side of the cover page. 
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14. User settings 
 

 

14.1 Multilanguage support 

The current version is available in English and German. The language can be 
changed by accessing  Settings -> User in the main menu and selecting a 
language from the drop-down list. 

Note! ReqEdit client needs to be restarted for the changes to take effect. 

14.2 Delete temporary files 

The „Delete temporary files...” button deletes all File backups, Temporary Files 
and File Changelogs stored in the local workspace. The ReqEdit changelog and 
settings are not deleted. 

14.3 ReqEdit Backup 

When a file is saved for the first time, ReqEdit automatically makes a backup 
copy of the initial state of the file and also starts the timed backup process. By 
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default, the program creates a backup every 10 minutes until it reaches 10 
backup files. After that, the oldest backup file will be overwritten. The number of 
minutes and number of backup files can be changed by the user in the „User 
settings” window. 
The timed backup process can also be disabled by unchecking the „Create 
backup” box. 

By default, ReqEdit stores the backups in the Windows user folder. This is a 
Windows 7 location sample: 
C:\Users\user_name\AppData\Local\ReqEdit\ReqEdit\BackUpFiles 

NOTE: The locations of the Log and Backup folders can be changed. More 
information can be found in the Program environment chapter. 

14.4 DOORS table attribute selector 

In this section you can select one of the 3 primary attributes to be displayed in 
DOORS tables. 

ReqIF.ChapterName = Object Heading 
ReqIF.Name = Short Text 
ReqIF.Text = Object Text 

14.5 Image caching 

To improve grid display performance, ReqEdit implements an image caching 
system for XHTML cells. By default, the cache size is set to 500 MB and can be 
changed by the user in the “User Settings” section. 

15. Document properties 
In the “Document” tab of the Settings -> Document section, you can edit the 
name, description and attributes of the current document. If your file is an 
archive or a multi document file, you can select any of the contained 
requirements documents and edit its name, description and attributes. 
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If you try to rename the document and use any special characters, you will get a 
message with a list containing all alowed characters. 

 

The attributes of the document can be added, edited or deleted exactly like the 
object attributes from the “Attributes” tab. On the right side you can see the 
value(s) of the selected attribute. 

In this tab you can also see some document statistics including: 

• Number of documents in file 
• Number of rows in selected document 
• Number of attributes in selected document 
• Number of attribute types in selected document 
• Number of incoming and outgoing links 
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16. Document views 
In ReqEdit, custom views can be created for requirements documents. Using 
views, you can hide certain columns and save the view for future use. Filters and 
sorting options are also saved. 

You can select an existing view from the drop-down list located on the toolbar. 
Two standard views are available: “All attributes” and “Main column”. 

 

A new view can be saved by clicking on the “Create new view” button on the 
toolbar and entering a name. You can also delete a view by selecting it from the 
drop-down list and clicking on the “Delete view” button. 
Note! The two standard views cannot be deleted. 

17. Templates 
You can create templates as normal reqif and reqifz files which you can later 
copy into the “Templates” folder inside the ReqEdit main folder. By doing so, you 
will have the option to use these templates when creating a new reqif or reqifz 
file. 

When creating a new reqif file or when adding a new document to a reqif file, 
you can only select simple reqif files as templates. 
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When creating reqifz archive files or adding a new document to a reqifz file, 
both reqif and reqifz files can be used as templates. 

 

NOTE: Multi-document files are not valid templates. 

18. ReqEdit Log 
 

For each action that modifies the structure of a document, an entry is created in 
the ReqEditEventLog file. The log entries will not store any actual data from the 
documents, just the actions performed in ReqEdit. 
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The log files can be found on the local settings of the OS user. This is a Windows 
7 location sample: C:\Users\user_name\AppData\Local\ReqEdit\ReqEdit\SystemLog 

 

19. ReqEdit Buttons 
 

It offers the most frequently used commands in the interest of faster working. 
The icons used here can also be found in front of the menu items 
corresponding to them therefore it can be set more easily which icon belongs to 
which menu item.  

      

 

                             

Moving the cursor above the icons, in the ToolTip it can be read which 
command can be performed by the given icon. The toolbar place of every icon 
can be changed, and it can be adjusted to the four sides of the working surface. 
This can be performed by dragging the four points located at the beginning of 
the toolbar to one of the four sides of the surface.  

20. Keyboard Shortcuts 
 

Users can reach the often used commands with shortkeys. On the menupoint 
we can see which shortkeys belong to each command: 
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The next list contains all the shortkeys, which are used in the program: 

• CTRL + O   – Open file 
• CTRL + N   – New file 
• CTRL + S   – Save file 
• CTRL + SHIFT + S  – Save as 
• CTRL + W  – Close file 
• CTRL + SHIFT + W  – Close all file 
• ALT + F4   – Exit program 
• CTRL + D   – Delete sorting 
• CTRL + F   – Find 
• CTRL + H   – Replace 
• CTRL + E   – Add new or edit filter 
• CTRL + A   – Activate/deactivate filter 
• CTRL + Q   – Delete filter 
• ALT + N   – Add new object below 
• ALT + SHIFT + N  – Add new child object 
• CTRL + TAB   – Switch between open tabs 
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21. Contacting Support and Help 

18.1 Help 

18.1.1 Help content 

Displays the content of the Help file. This is contained in a PDF file which can be 
found besides the program in the HelpFiles directory. By clicking on the menu 
item, it opens the default PDF handler program used in Windows.  

18.1.2 License info 

Displays the license information of the program.  

18.1.3 Check for update 

By clicking on the menu item, a window will open and check if there are any 
updates available for your version. If there is an update available, the window 
will display the version and ask if you want to update. 

 

If you click on the „yes” button, the program will close and the updater window 
will apear and display the progress bar for the download and unpacking of the 
new version. 
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After the update finishes, the updater will ask if you want to open the new 
version or close the program. 

 

 
If an error occurs during the download or the unzipping of the new package, the 
current version can still be used without a problem. You can check the update 
logger in your workspace at ReqEdit\Logger\UpdaterHistory.log.  
If an error occurs during the overwriting of the old version, you will get an error 
informing you to do a rollback to the old version. This can be found in the folder 
„latest_backup_<datetime>” in your workspace at 
ReqEdit\UpdaterWorkingDirectory. You can copy the content of that folder back 
into your ReqEdit folder. 

NOTE: More information on the locations of the Log and Backup folders can be 
found in the Program environment chapter. 

 

18.1.4 About ReqEdit 

Displays information about of the program. 
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Version number 
The version number consists of four parts:  

• Major version 
• Minor version 
• Build number 
• Revision 

Major and Minor numbers change only in case of publishing of a newer version, 
Build and revision numbers change automatically during updating. Major and 
Minor numbers found here can be seen in the header of the document 
belonging to the program, by which the program can be compared with the 
document versions.  

18.2 Support 

You can find a self-help forum here https://reqteam.zendesk.com/hc/de. 

If the self-help resources have not provided a resolution to your problem, you 
can contact ReqEdit Support for assistance in resolving product issues. Please 
send an email to: support@zendesk.reqteam.com 

18.3 Error reports 

In the case of an improbable error event, ReqEdit offers the possibility to send 
an error report directly to our support team. After the error report is sent, a 
support ticket will be created automatically and the user will get an answer as 
soon as possible. After the error is fixed, the sender of the error report will be 
contacted and a patched version of ReqEdit will be provided. 

The data gathered in the error report does not include any content from your 
documents, just information about the actions that took place before the error 
occurred. This data helps our developers and support team reproducing, 
discovering the source of the problem and fixing of the error. 
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22. Notices and limitations 

22.1 Insert images and OLE objects 

Inserting external references like images or other file types are not possible in 
simple ReqIF files. The software only allows adding images and external file 
references to ReqIF Archives (file ending “.reqifz”). If you intend to add files to 
the document you created, you have to use the menu “create new archive” for a 
new file. If you already have a file, create a ZIP archive of this file and rename 
the file ending to “.reqifz”. So it is possible to add new file references to the 
document. 

Note: At the moment we do not fully support the import of OLE objects 
containing .wmf files. 

22.2 Generate preview images of OLE files 

The current ReqEdit editor is not able to generate preview images during 
imports or if they are directly added in the application. A file-type icon will be 
inserted instead of the preview (e.g. a Word or Excel symbol). 

22.3 Import/Export OLE objects  

It is tested with the Atego Requirements Synchronizer version 2.4 and IBM 
Rational DOORS 9.5.2. Earlier versions should also work but have not been 
tested. 

If you use older Versions of IBM Rational DOORS or not export the “ReqIF 
Compressed” Variant, then DOORS will export the ReqIF and all this OLE objects 
in the same directory.  
Please use for export always a new directory then compress the content of this 
directory (without the directory name) in a zip archive. Check if the ReqIF file 
and all of the OLE objects are in the root folder of the archive. Rename the file 
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to <<filename>>.reqifz instead of “.zip”. After this operation you can import this 
file to ReqEdit and after editing it also export to IBM Rational DOORS.  

If you use IBM Rational DOORS 9.4 you need to uncompress the generated file 
by ReqEdit-Export in an empty directory before import. 

If exports are done directly by IBM Rational DOORS, in most of the cases the 
tool will not offer the preview images. Instead a small cross icon is displayed 
(broken images) as a preview image, but the linked OLE object still exists in the 
background. Please don’t delete this symbol, because then also the linked OLE 
object will be deleted. 

22.4 Import large OLE Files 

For the conversion of  OLE objects we need contiguous memory free for the 
content, because of the limitations of the selected platform .NET 3.5.1 and 32bit 
address limitation . The conversion of 1 MB OLE file takes about 15-20MB free 
memory with the current implementation. A memory free functionality has 
been build to ensure that no problems occur, but in very seldom cases the 
program is not able to set enough contiguous memory free for the conversion. 
If this happens then the OLE file will be wraped inside an RTF file and any file 
types will be opened inside Microsoft Word. 

On 64bit OS all available memory can be addresed and so conversion of bigger 
files is possible. For any file conversion the program needs about 20 times more 
free memory than the size of the file that will be converted. 

22.5 Export large OLE Files 

Exported files that have OLE objects larger than 40-45MB cannot be imported 
into IBM DOORS that is connected to IBM DOORS server 9.5 because of a size 
limitation on the server side. 
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22.6 Copy and Paste 

It is possible to copy text content from an external source with Ctrl-C and to 
paste it in the ReqEdit Client with Ctrl-V. But all the formatting will be stripped 
from the copied text. The consequence is that all text formats (bold, italic, font 
size font type) and colors will be lost. Please format the pasted text after 
inserting it with the given format possibilities, offered by the tool. 

Copy of external referenced files is not possible, so inserting images or other 
documents are not possible with copy and paste. Please use the menu entries 
“insert Image” or “Insert file” for this action. 

22.7 Program environment 

The standard location of the ReqEdit program files is: 

C:\Users\user_name\AppData\Local\ReqEdit\ReqEdit\ 

This location can be changed by editing the “ReqEditSettings.xml” file found in 
this path. The setting that needs to be changed is the 
“ReqEditEnvironmentPath”. Copy the path to the folder you want to use 
between the “value” tags and save the file.  

Example: <value>D:\Programs\ReqEdit</value> 

If the value is set to “default”, the standard location will be used. 

After you change the path, ReqEdit will create the new program files and folders 
at the next program start. 

NOTE: The old program files will not be moved automatically. If you want to 
keep them, please copy them manually to the new location. Also, the 
“ReqEditSettings.xml” file cannot be moved to another location. 
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23. Appendix 

ReqIF Namespace Reserved Attributes 

ReqIF Attribute Name Attribute type Short description 

ReqIF.ForeignID String The ID of a requirement that can 
be used by all tools. 

ReqIF.ForeignCreatedBy String The username of the person who 
created the requirement. 

ReqIF.ForeignCreatedOn Date The date on which the 
requirement was created. 

ReqIF.ForeignCreatedThru Enumeration Method through which the 
requirement was created (manual 
input, import, copy etc.) 

ReqIF.ForeignModifiedBy String The username of the person who 
did the most recent change on the 
requirement. 

ReqIF.ChapterName XHTML The heading of a requirement. 
ReqIF.ChapterNumber String The hierarchy number of a 

requirement. 
ReqIF.Name XHTML The short description of a 

requirement. 
ReqIF.Text XHTML The body of a requirement. 
ReqIF.Description XHTML The main description of a 

requirement. 
 

ReqEdit Namespace Reserved Attributes 

ReqEdit Attribute Name Attribute type Short description 

ReqEditID Integer The ID of a requirement. 
ReqEditModifiedOn Date The date on which the 

requirement was changed most 
recently. 

ReqEditModifiedBy String The username of the person who 
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did the most recent change on 
the requirement. 
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1.  About this manual 

Welcome to ReqEdit XML Editor, a tool that is designed as a supporting tool for 
ReqEdit. The user has the possibility to correct the XML text file, if the file 
contains invalid ReqIF content (like invalid IDS or wrong tags). This user manual 
describes how to use the features of the ReqEdit XML Editor.  

The editor is only usable for ReqEdit Premium user. 

2. How to start the XML Editor  

The XML editor can be easily started from ReqEdit, by click on the menu “Add-
Ons” à”ReqEdit XML editor”. The editor will only run if ReqEdit is open, and will 
be automatically closed if you close ReqEdit. 

3.  The XML editor 

If you open the editor, you will see four sections (from top to bottom): 

1. Toolbar 
2. Content area 
3. Validation box 
4. Status bar   
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3.1  Toolbar 

Open: open a ReqIF file or ReqIFz archive in the editor. The ReqIFz archive will 
be automatically unpacked and all the containing documents will be opened. 

Save: save changes in the current file. If the file is part of one ReqIFz archive, all 
the changes inside the archive will be saved and the files will be packed as well. 

Save As: save the current content in a new location 

Close: close the current document. If the file is a valid RIF or ReqIF file, then you 
will have the possibility to open the file in a new ReqEdit instance. 
Please take in consideration, that each ReqEdit instance consumes one network 
license. With a user license, you can open unlimited instances on your computer. 

Undo: undo last user action 

Redo: redo the user action, that was reverted by undo 

Goto Line: jump to the line entered in the XML file. The range displayed in the 
dialog is determined by the total lines of the current file. 
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Search/Replace: search for a text inside the document. Enter the search text 
and press the button “Find Next” to start or to continue the search. If you press 
the button “Mark All” all findings of the entered search string will be highlighted. 

 

To replace a part of a text you need to enter the search string and the 
replacement in the corresponding input fields. Press then the “Replace” button, 
to replace the next occurrence of the search string. Alternatively, you can press 
the “Replace All” button, then all the occurrences of the search string in the 
current file/tab will be replaced. 

Additional to default search you can change some options of the search. If you 
like to search the exact entered text, then select “Match case” option. If you 
searching for complete words (starting and terminated by a non-character) than 
select the “Match whole word” option. You can search also in reverse order by 
selection the “Search up” option. 

You can search as well in collapsed XML tags if you switch on the “Search hidden 
text” option. If you want to limit the search, then you can select the section with 
the mouse and then select the option “Search in selection”.  

Collapse all nodes: collapse all xml nodes in the current file/tab. So only the 
root node is visible. Now on the right side you can click on the “+” sign right 
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beside a tag to make the content of tag visible. If you click on the “-“ sign, then 
the content of the tag will be hidden. 

 

Expand all nodes: expands XML all nodes in the current file/tab 

Validate Document: validate the document as ReqIF or as RIF. The selection of 
the validation can be done by the drop down selection right beside the icon. 

 

Help: opens the ReqEdit documentation containing this documentation. 

3.2  Content area 

The content area displays the single ReqIF files as syntax highlighted XML 
document and line numbers. As known from other XML editors you have the 
possibility to collapse and expand single tags in the XML file (see description in 
“Collapse all nodes”).  

If you open a ReqIF archive that contains multiple files, then all single ReqIF files 
will be displayed in separate tabs. 
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3.3  Validation box 

In the validation box the user can automatically see if the XML document is not 
well formed, including the line number and the referring tag.  

A XML document is contained well-formed if: 

- XML documents must have a root element 
- XML elements must have a closing tag 
- XML tags are case sensitive 
- XML elements must be properly nested 
- XML attribute values must be quoted 

 

 

3.4  Status bar 

Contains the copyright reference and the current version of the ReqEdit XML 
editor. 


